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Overview

Thank you for purchasing the Pulsar vB (vBOO1) Hand Arm Vibration Meter
from Pulsar Instruments Plc. This manual is designed to show you how to
install and operate the vBPlus software to be used alongside your vibration
meter.

Should you need any further assistance in the operation of this software
please contact us and we will be happy to help. We can also recommend
suitable training courses in the UK should you wish to become a Competent
Person for Human Vibration in the eyes of the law.

We pride ourselves on providing high quality products for our customers, and
I'm sure you will find that this vibration analysis software meets those
standards. We suggest however that if you are dissatisfied with this product
in any way, please tell us immediately: -

Phone: +44 1723 518 011 or email: sales@pulsarinstruments.com

g ‘ \\/ //v / ~
7 /l XS (% C s
KA '«
Simon Rehill

Managing Director




Copyright

This manual is copyrighted with all rights reserved. The manual may not be
copied in part or in whole without the prior written consent of Pulsar
Instruments Plc.

Minimum System Requirements

e Pentium 4 1.5 GHz or Athlon XP 1500+ processor or higher
e 200MB Free hard disk space
e 256MB Ram
e (One free USB Port
e (Operating Systems [minimum operating system requirements also apply];: -
e Windows XP SP3
e \Windows Vista SP2
e Windows 7 - 32 or 64 bit
e Windows 8 - 32 or 64 bit
e Windows 8.1 - 32 or 64 bit
e Windows 10 - 32 or 64 bit

Windows 8.1 RT is not compatible with vBPlus.

Contacting Pulsar

This manual contains complete operating instructions for the Pulsar software
vBPlus, read it carefully and you will quickly become familiar with its features
and operation.

If you do encounter problems with the operation of your software please feel
free to contact customer support with your enquiry on: -

Telephone: +44 (0)1723 518011
Fax: +44 (0)1723 518043
Website: www.pulsarinstruments.com

Email: sales@pulsarinstruments.com
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Chapter 1

Installing vBPlus

Installation of vBPlus requires full administrative privileges, please seek advice
from your IT manager if required.

This example shows how to install vBPlus on Windows 10, installation on
other operating systems will be similar but may show slight variations in
screens: -

1. Unplug any vibration meter device from the PC or laptop.

2. If you have downloaded vBPlus double click the saved file named vBPlus
Setup.exe to start the installation.

3. If you have a vBPlus installation USB Flash Drive, insert the drive into a
USB port on your computer and double click the file named vBPlus
Setup.exe to start the installation.

4. Depending on the operating system setup you may need to allow
permission for the application to be installed. Click Yes to continue and
start the installation.

User Account Control pod

Do you want to allow this app from an
unknown publisher to make changes to your
device?

vBPlus Setup.exe

Publisher: Unknown
File origin: Network drive

Show more details

Yes Mo




Click Yes to begin the installation of vBPlus, this will prompt the following
screen to be shown: -

Select Setup Language >
Select the language to use during the
installation:

English -
Cancel

Select the installation setup language and click on OK to begin the
installation.

Follow the on screen instructions carefully to install your software
correctly.

After navigating through the various setup windows your vBPlus software
Is ready to install.

It is recommended that all other applications are closed before
proceeding.

ﬂ Setup - vBPlus — X

Ready to Install
Setup is now ready to beqin installing vBPlus on your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x8&)\PulsarvBPlus

< Back Install Cancel




During the installation of vBPlus the USB device drivers for your vibration
meter need to be installed: -

@ FTDI CDM Drivers ol

FTDI CDM Drivers

Click ‘Extract' to unpack version 2,12.28.2 of FTDI's Windows
driver package and launch the installer,

wiww fidichip.com

Cancel

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to wark.

To continue, click MNext.

Click on Next to start Driver Installation.



Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

fou can now connect your device to this computer. f your device
came with instructions, please read them first.

Driver Name Status

w* FTDI COM Driver Packa... Readyto use
s FTOI COM Driver Packa... Readyto use

[==]
1]
0

When the driver installation is complete the above screen will be displayed.

Click on Finish to close the Driver Installation.

ﬂ Setup - vBPlus —

Completing the vBPlus Setup
pUlsar g

Setup has finished installing vBPIlus on your computer, The
application may be launched by selecting the installed
shortouts,

Click Finish to exit Setup.

Pulsar vBPlus

Professional Vibration
Analyziz Software

Click on Finish to complete the vBPlus installation.



9. Your vibration meter may now be attached to a spare USB port on your
laptop or desktop PC.

Note that the vB instrument must be turned ON.

The first time the meter is attached, windows will automatically configure
the device for use. Depending on your operating system, the following
windows may be displayed: -

Device Setup

Installing Vibration Meter

Please wait while Setup installs necessary files on your system. This may take
several minutes.

When complete your computer will be ready to download data from your
vibration meter.



Chapter 2

vBPlus LITE

Pulsar instruments are supplied with a free version of vBPlus which has
limited functionality.

Every time the software is opened, it will operate with limited functionality until
the software has been unlocked. See Registering for further details.

# pulsar

Pulsar vBPIlus | [TE

Professional Vibration Analysis Software

© 2018 Pulsar Instruments Plc.

This manual describes the functions that are available in the registered
version of the software.

Functionality

In vBPlus LITE the following viewing screens are either unavailable or will
display Not available: -

» Exposure Calculator
» Merge / Combine
» Adding Images

» Trend Analysis

» Add New Record



Registering

vBPlus LITE can easily be unlocked by entering a valid Unlock Key Code which
can be purchased at any time.

If or when you have purchased vBPlus you can unlock the software using the
3 Step Procedure below.

Please note that the Encryption Code provided in Step 1 is randomly

generated, therefore if the software is removed and installed either on the
same PC or another PC you will need to repeat all the steps outlined below.

Step 1

Copy the Encryption Code from the ‘Enter KeyCode' screen. This displays
each time vBPlus LITE starts, or alternatively it can be opened by selecting
‘Help’, ‘Licensing...’ from the toolbar menu.

€D Enter KeyCode — O et

You are currently uzing Pulsar vBPlus LITE. |f pou have already, or
wauld like to purchase the full version, then please contact Pulzar on:-

+H4[01 723 /18011
To continue uging Pulzar vBPluz LITE, click Cloge
zalesi@pulzarinstruments. com

Encryption Code |HGDZKED.-‘-‘-.FF

ke Code || Pazte

Get Key Code Activate Cloze |

Step 2

Click on Get Key Code and enter the required fields to obtain your Key Code
immediately. Please note an internet connection is required.

Alternatively please contact Pulsar on 01723 5180171



Step 3

Customer detalils will be validated and a valid Key Code will be issued by either
email or telephone.

Enter the issued Key Code in the blank Key Code cell and press ‘Activate’.
All Unlock Key Codes must be entered in UPPER CASE.

If the entry is not valid then the following will be displayed: -

Pulsar vBPlus LITE oo

l . Inwalid Key Code

If a valid Unlock Key Code is entered the following will be displayed. Please
click ‘OK’ and then restart vBPlus for the Unlock Key Code to take effect.

Pulsar vBPlus pod

Thank you for purchasing Pulsar vBEPlus.
¥/ Please restart the application

Your software is now registered and each time you start the software it will
open with no restrictions.

pu/sar

Instruments P/r:

Pulsar vBPlus

Professional Vibration Analysis Software

© 2018 Pulsar Instruments Plc.




Chapter 3

Connectivity

Downloading recorded data from your vibration meter into vBPlus is only
possible if you are using the correct cable and the required device drivers are
correctly installed during installation of the software.

Downloading recorded data from your vB instrument into vBPlus requires a
spare USB port on your desktop or laptop and the installation of the supplied
USB device driver which is installed during the installation of vBPlus please
see Installing vBPlus , Chapter 1 for more information.

Regardless of your operating system the USB device driver MUST be
installed to allow communication between your vB instrument and your PC.

If the incorrect device driver or no device driver is installed then your
instrument will not download.

Ensure your instrument is powered ON and then connect the supplied USB
cable as shown below: -

vB Vibration Meter

/\/ ¥~ USB Micro B

PC USB Port

The instrument is now ready for downloading data into vBPlus.

Please be aware of the Auto Shutdown feature on the vB instrument if no
keys have been pressed for 10 minutes. Download will not occur if this
feature has been activated.



Chapter 4

Getting Started

vBPlus can be run using either of the two options below: -

1. Double click on the desktop icon f}or‘ single click on the quick launch
icon, both of which are named vBPlus. Note these shortcuts are only
available if selected during the installation process. Quick launch on
Windows 7 or above will need to be turned on, alternatively simply pin the
desktop icon to the taskbar.

2. On Windows 7 or below click the 'START button and select ‘All
Programs’, choose the folder ‘'vBPlus’ and finally select the application
‘'vBPlus'.

On Windows 8 or above, press and hold the Windows key on the keypad
then press S. Type vBPlus in the search bar and then select the
application vBPlus.

Opening Home Screen

The display area is split into two sections.

© Puisa 881us P
File

Toolbar
Data Viewing Screen

File Browser _
Quick Access Buttons

¥ ———— Column Divider

The left hand column named the ‘File Browser’ will display details of any file
opened within vBPlus.

The right hand area named the ‘Data Viewing Screen’ displays downloaded
data and instrument information relevant to the recording.

10



The Home Screen also contains quick access buttons to useful features of
vBPlus.

The File Browser or Viewing Screen can be resized horizontally by grabbing
and moving the column divider.

At the top left of the screen is the Toolbar which gives quick access to the
commonly used functions within vBPlus.

Toolbar Options

The following toolbar options are available ([some options listed below require
an active file to be open]: -

File Menu

Download Download data from an instrument

New Create a new blank folder

Open Open a saved file

Save Save the current data to a file

Save As Save the current data to a new file
specifying a new name

Close Close the active data file

Close All Close all the open data files

Print Print current view

Exit Close the application

View Menu

Toolbar Toggle toolbar on / off

Settings Open the Options window for Vibdata
settings and user preferences

Help Menu

vBPlus Help View the help file

Pulsar Homepage

About vBPlus
Update Instrument

Opens Pulsar's Website in a browser
window

Display the current software version
Update vB instrument firmware

11



Edit Menu

Eile Edit View Help

| Glfs|p of )

[ Example Folder Mame
E‘ ............ ; EI'ﬂD'FI_',JEES
............ ol H

Rename Folder

Group Folder By *

Click on the folder name and then click on Edit or right click on the folder
name to show the options above and described below: -

Rename Folder
Group Folder By

b Date

> Location
> Tool

> Record
= Employee

Date
Location
Tool
Record
¥ Employee
Regroup and sort the measurement folder
by Date, Location, Tool, Record or Employee

File Edit View Help

| [ilrelB| O] =

. Example Folder Name
Bl g EMIDIOY
............ "}

Mew Employee

Click on HAV within the group and then click on Edit or right click on HAV
type to show the options above and described below: -

New ...

File Edit View Help

| Gleslm| ol =

. Example Folder Mame
E|- Emp!!:_.,.ees
’1 Hen

| GO
| ED
| JAMES

Create new -
e Employee, Tool, Record, Location or Date
Depending on Grouped By selection

Mew Employee

Add Picture

Copy To Clipboard
Rename Employee
Delete Employee

Print Current Yiew

Delete Measurement
Copy Measurement
Paste Measurement

Exclude Measurement

Edit Exposure Time
Log Information »

Edit Mote

12




New ...

Add Picture
Copy To Clipboard
Rename ...

Delete ...

Print Current View
Delete Measurement
Copy Measurement
Paste Measurement
Exclude Measurement
Include Measurement
Edit Exposure Time
Log Information

b Edit
> Copy To Clipboard
Edit Note

Click on a recording and then click on Edit or right click on the recording to
show the options above and described below: -

Create new -

e Employee, Tool, Record, Location or Date
Depending on Grouped By selection

Add a picture to file

Copy selected file data to clipboard
Rename either: -

e Employee, Tool, Record or Location
Depending on Grouped By selection

It is not possible to rename by Date
Delete Individual selection of either: -

e Employee, Tool, Record, Location or Date

Depending on Grouped By selection
Print current view
Delete selected indivdual measurement
Copy selected measurement
Paste selected measurement into group
Exclude / Include selected measurement
from calculations.
Enter a new Exposure Time

Edit

Copy to Clipboard

Edit Log Information such as Tool, Employee
Copy all Log Information to the clipboard
Add a Note description to the measurement

Toolbar Buttons

File VWiew Help

v GIEE o = o

From left to right, the buttons perform faster access to the following

common actions: -

@ Download data from an instrument

Create a new blank folder

Open a saved file

"I Save selected data to a file

Copy current view data to clipboard

™ Print current view

Home Screen

13




User Preferences and vBPlus Settings

To change user preferences and settings within vBPlus, select ‘Settings’
from the ‘View’ menu.

Some settings may require a restart of vBPlus to take effect.

General Tab

9 Settings X
Generall Fields] Displa_l.l] Eriterial

Frogram Options

Group Downloaded Data By |T|:u:u| ﬂ

Comparny Optians

Company Mame: |

Logo File: |

Browse

Working Directonies

Files: |E:"-.P'ru:ugram Filez [#36]%PulzarwBPlus

Images: |I::"-.P'r|:|gram Files [#361%PulzarwBPlus\lmages

Browse

] Cancel

Program Options

Group Downloaded Data By:
Select how downloaded data will be grouped. The available grouping
methods are by: -

e Employee, Tool (Default), Record, Location, Date

Data can be regrouped at any time if required after it has been downloaded.

14



Company Options

Company Name:
Enter your company name here.

Logo File:

Browse to the location of your company logo image file which is used when
printing documents.

The image size is 170(W) * 57(H] pixels and must be in the .omp or .wmf

format.

Working Directories

Files:
Point to the folder where you wish to open and save your data.

Images:
Point to the folder where you wish to open image files from.

Note that image files are 100(W] * 100[H] pixels and must be in either of
the following formats: -

Jpg
.bmp
gif
.png

15



Fields Tab

€ Settings >
General  Fields l Dizplay ] Criteria l
Measurement Mode | H ard-Arm *ibration J
Data Format | Screen j
Arailable Fieldz Current Fields
Paints [13m] Add 5> Mo Mave Lp
F'-:unt_s [1H] Time
Dorminant <4 Remove Date . Move Down
Employes Druration
Lacatian Mate
Record =,
Tool by
Serial Mo £
Instrument oL
Wersion Yector Sum
Fac Cal Due b & Do rmnz]
[Initz bl as Dur[L rmnz]
M ode Exp
|nteqration Aila]
R ange Tyl
Senzgitivity Expozure Paintz
ok Cancel

Use the Fields tab to select which information is: -

¢ Displayed on screen
e Copied to the Clipboard
¢ Printed

Use the drop down box labelled Data Format to select any of the following
options: -

Screen Select for parameters displayed on screen
Clipboard Select for parameters copied to clipboard
Print Select for parameters to be printed

Parameters in the Current Fields list will be displayed, copied or printed.

16



Highlight items under Available Fields and click on 28> |40 add the
parameter to Current Fields.

To remove parameters, highlight the item and click on ™"

To change the order in which the parameters are displayed, copied or
printed, highlight a parameter in the Current Fields list and then use the
Move Up or Move Down buttons to move the selected item up or down the
list.

Exposure Points are not moveable or removable from the Current Fields
and are always the last parameter in the item list.

Attempts to move Exposure Points will display the following message: -

Pulsar vBPlus Pro pod

Exposure Points must be the last item in Current Fields and is not
moveable,

Attempts to remove Exposure Points will display the following message: -

Pulsar vBPlus LITE ot

Exposure Points must be selected in Current Fields and cannot be
removed.

17



Display Tab

0 Settings >
General] Fields Display l Eriterial
[araph Chart Optionz
—_— L]
Chart Line wfidth: .
Ok, Cancel

Display Options
Chart Line Width:

Move the slider to determine the line width used for graphing.

18



Criteria Tab

0 Settings >

General] Fields] Dizplay Eriteria]

L ritg
Dizplay Units: |Metric J
dB Reference Walue: |e“1 05 J

Hand Armn Yibration

Action Value: 258 Lirnit " aluie: ]

] Cancel

Use the Criteria tab to change the Action and Limit values as required.

In the UK, The Control of Vibration at Work Regulations 2005 stipulates the
following Action and Limit Values: -

Vibration Type Action Value (m/s?) Limit Value (m/s?)
Hand Arm 2.9 0.0

19



Chapter 5

Downloading, Opening and Saving Data

Downloading Data

Please ensure the required drivers have been installed during installation, see
‘Chapter 1, Installing vBPlus’ for more information.

Downloading data from your instrument is achieved by connecting your
instrument to your PC or laptop via the supplied USB cable, see ‘Chapter 3,
Connectivity’ for more information.

To download the data from your vB follow the procedure below: -

1. Ensure that the vB vibration meter is ON.
Connect the USB lead to the instrument and to the PC.

2. Select ‘Download’ from the File menu or click on the Download icon ¥ and
vBPlus will attempt communication with your Vibration Meter.

Once the instrument is identified the acquisition of available logs will begin.

0 Download Progress X

Acquiring list of logs...

20



3. With acquisition complete a list of all available measurements is displayed.

0 Download Data
Select Al Clearall

pes

Hawd - WEO01 Select the Measurement(z] pou wizh to download and click OF
Date | Tirme | File: Marne | Mode

[119/03/2018 093100 example

[[119/03/2018 09:35:12 examples

[[119/03/2018 19:36:49 example3

[119/03/2018 09:33:29 exampled

] 19/0322018 09:40:32 exampled

[+ Merge Folders [ Combine Logs oK, |

Available measurements can be sorted by clicking on the field name.

Sorted fields are identified by having the symbal > at the left of the field
name. Reverse the order by clicking on the field name again.

The image below shows reverse sorting by File Name.
Field Names

\

€} Download Data >
Select 4l Clearall

Ha - WBO01 Select the Measurement(s] pou wish to dawnload and click OK

Date Tirme »File Mame | Mode

0352018 094032 exampleh

] 19/0322018 09:38:29 exampled

[[119/03/2018 09:36:49 example3

[[1 19032018 09:35:12 examplez

[119/03/2018 19:31:00 examplel

M—

[v terge Folders

[ Combine Logs

QK

Cancel

21




4. Select which measurements are required by clicking in individual tick
boxes or by selecting ‘Select All’ and then choosing Measurements.

€D Download Data ped
Select All - Clearall

Haw - WO Select the Measurement(z] pou wizh to download and chick QK

Date Time File Marne | Mode

19/03/42018 19:31:00 examplel

19/03/2018 093512 examplez

19/03/2018 09:36:49 exampled

19/0342018 09:33:29 exampled

19/02342018 09:40:32 exampleh
[v Merge Folders [v Combine Logs oK. L

22



9. Select or Deselect Merge Folder and / or Combine Logs using the tick
boxes.

Selecting Merge Folders will place the data to be downloaded into the
active folder that is open in vBPlus. If no folder exists or if this option is
not selected then the data will be downloaded into a new folder.

Selecting Combine Logs will combine each measurement of the same
name and of the same type into one measurement.

€D Download Data ped
Select &4l Clearall

Hah - WEOO Select the Measurement(s] vou wish to download and click 0K,

Date | Time | File: Harne | Mode |
19/02342018 19:31:00 examplel

19/03/2018 093512 examples

19/0342018 09:36:49 example3

19/03/42018 19:33:29 exampled

19/03/2018 094032 exampleh

[w terge Folders [ Combine Logs I oK. |

6. Once all preferences have been selected, press the OK button to start the
data download from the instrument to vBPlus.

23



Error Messages

If vBPlus does not receive a response from your instrument then you will be
shown the following error messages: -

Pulsar vBPlus Pro pod

Pulsar vBFlus Pro Failed to Connect to Your Instrument. Please Ensure
Your Download Cable is Connected and Try Again.

If this occurs please see ‘Chapter 3, Connectivity’ for instructions on
connecting your instrument.

If an instrument is detected but no files have been recorded then the following
message is displayed: -

Pulsar vBPlus Pro pod

Mo files exist on the Host Instrument. Please create some recordings
and try again.

If this occurs please create some recordings on the instrument.

24



Opening Data

To open a saved data file choose ‘File’, ‘Open’ or click the Open File ¥ icon.

) Open Datafile *
™ » ThisPC » Desktop » vBPlus » Examples v O Search Examples 2
Organize + MNew folder = 1 @

MName Date modified Type Size
7 Quick access

| | vB Samples.cd3 3/15/201810:33 AM  CD5 File 4KB
¢@ OneDrive

[ This PC

¥ Metwork

File name: v| Pulsar Linear Vibration Data File ~

The initial default location for file storage is found under Working Directories
from the General tab of Settings, this location can be changed if required,
however vBPlus remembers the last folder location used enabling fast folder
access.

To open the selected file double click on it or highlight it by a single click of the
mouse button and then click on the ‘Open’ button.

25



Saving Data

To save data to a log file choose ‘File’, ‘Save As’ or click the Save = icon.

) Save Datafile *
™ » ThisPC » Desktop » vBPlus » Examples v O Search Examples 2

Organize = MNew folder =z -
Name Date modified Type Size

7 Quick access
| | vB Samples.cd3 3/15/2018 10:33 AM  CD5File 4KB

f@a OneDrive

[ This PC

¥ Metwork

File name: -

Save as type: | Pulsar Linear Vibration Data Files (*.cd3) ~

» Hide Folders Cancel

The initial default location for file storage is found under Working Directories
from the General tab of Settings, this location can be changed if required,
however vBPlus remembers the last folder location used enabling fast folder
access.

Enter a file name and then click on the ‘Save’ button.
Once a file name has been specified quick saves are possible using the Save

. ] g y ¢ y . . g 3
icon 2 or ‘File', ‘Save’. To specify a new name, where required, use ‘File’,
‘Save As’ again.

26



File Browser

The File Browser is located at the left hand side of the screen. It is used to
select which information is displayed in the Data Viewing screen.

The example below describes how to use File Browser: -
i.  Open or download a file.

File View Help

| GlEE o = o
I-_{I, Pulzar +B 15/03/18 10:27:03
é ............ T Toolz

ii. Click on the + to the left of the vibration type icon to display the
downloaded or saved file information.

File Edit View Help

| QB B @ o

F{} Pulsar vB 15/0318 10:27:03

B

-------------- [ Rivet Gun
-------------- Tarque Driver
Spanner Gun

Group by method

Click on the file you wish to view which will then appear in the Data Viewing
Screen. By default all files are grouped by Tools, this can be changed under
Settings.

To regroup an open file, right click on the folder name and choose ‘Group
Folder By’ -

File Edit View Help

o Gl ol S 8]

Ful ar vB 15/031810:2

Rename Folder |

[ — o Hasts Group Folder By » Date
.............. Bive. .
.............. Tgrque Diriver Location
.............. Spanner Gun . Tool b
Record
Employee

27



Group By Date:-

File Edit View Help

&| GelE ©f =
E{W
E ............ .. ates

[ — 15- Ha!
D 0540318

Group By Record:-

File Edit View Help

| Gl|E| 0 = o
ST

ey % Records
e — ’5‘ Han

It is also possible to rename folder names by right clicking on the folder name
and selecting ‘Rename Folder’.

Group By Location:-

File Edit View Help

| [FE|E B & o
O Pusand 503AR 102708

El@ Locations
[ — ;5 Haw

S—
Site 1

Group By Employee:-

File Edit VYiew Help

| GrelBl o = o

E\J;I,_’_ Example
E|_ Empllj_llJEES
[ — G’ Hews

-------------- Jade Wiight
-------------- Gemma Atkinzon

Jay W alker

Rename folder name

Enter a new name far thiz folder.

Cancel |

ped

Pulsar vB 15/03/18 10:27:03

Enter the new name and press Ok. The renamed folder will be now be

displayed: -

File Edit View Help

| G| ©f =

.............. Jigzaw
.............. Harmrmer Crrill
.............. Grinder

28




Chapter 6

Using vBPlus

Data Viewing Screen

The Data Viewing Screen is the main area at the right hand side of the screen
which shows the recorded data for the chosen file in the tree view.

Tree View

Data Viewing Screen

Tab Buttons

File Information

] File Image
Instrument Details g

You will have the following selectable tab buttons at the bottom of the viewing
screen: -

e (Calculator
e Cumulative Data
e Trend Analysis (if more than one recording is grouped]

Click these to change the display in the data viewing screen.

29



Calculator

The Calculator tab displays the calculated variables selected under ‘Options’,
‘Fields’ for the recording selected and is always available for any recording.

Where multiple entries exist, click on the entry to highlight it. The relevant
instrument detalls, file image and file information will be shown. The data for
the selected file will also be shown when viewing different screens in the data
viewing area.
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[ digsam 3_|1347|18/3/18] 000031 27 140 377 447 3 1000 w224 |Ves | @1 |
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Firmncars Version Numbes. 201
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Log Information:
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Exposure Points

The vibration exposure point system is based on the UK’s Health & Safety
Executive’s system where vibration magnitude and exposure time are given in
exposure points rather than ms®,

Partial exposure points of merged recordings are added together to produce
a total points exposure for a working day.

Partial points are displayed by default, Points(1hr) and Points(15m] will need
selecting in order to be displayed, copied or printed. See User Preferences
and vBPlus Settings under Chapter 4 for more information.

Partial
Exposure

i F T I T Y Wox DVl [ Exp |48 | o | ponure Por B

I I I I 5 H
e B B o R oints
il 140 k¥l 447 0230 1000 w22 [vel @ |

&0

Exposure
Points

Each recording and the total exposure points are colour coded using the
following criteria: -

Hand Arm
>0 &<100 GREEN
>=100 & <400 ORANGE

SY
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Drag & Combine Data

Whilst on the Calculator screen it is possible to use the drag and combine
feature of vBPlus.

Click and hold the left mouse button on the data you wish to drag, the mouse
will switch from an Arrow to a Pointed Hand.

0 Pulsar vBPlus Pro - C:\Program Files (x26)\Pulsar\wBPlus),
File Edit View Help

& BIFE O = &
I Pulsar vB 14/03/18 15:25:45 Mo | Time ] Date
E ............ T T|:||:||3. 1
[ — {‘\' Hashs €|1
.............. Jigzaw
.............. Harmmer Diil

Keep the mouse button down and move the Hand over the area on the Tree
View where you wish the data to be placed then release the mouse button.

0 Pulsar vBPlus Pro - C:\Program Files (x88)\PulsarwBPlus',
File Edit ¥iew Help

& [3]Fs[E o = o
-_;;; Pulzar vB 14/03/15 15:25:45 Mo | Time | Date
[ — 'r Tools
[ — {ﬂr Han
.............. Jiggaw
.............. Hararner Dirill

Data items such as Units, Type or Date must match to perform the
requested operation.

If the drag is not possible then vBPlus will automatically place the data in the
correct location, creating folders as and where required.

The overall combined A(8) and Exposure Points are then calculated on each
recording that is in the calculator screen.
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Cumulative Data

To view cumulative data use the Cumulative Data tab.

The cumulative data is a single overall figure calculated or measured over the
measurement period for each available axis.

Individual data for recordings that have been combined can be viewed but are
selected at the calculator screen. The information from the Calculator
screen for the selected log is displayed at the top of the Cumulative Data
screen to easily identify which recording is selected
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Trend Analysis

Combined recordings allow a Trend Analysis tab to become available.

Use this tab to plot graphically the cumulative average for each individual
recording within the combined set.

The plot is graphed in the order the list is displayed in the Calculator screen
(Time and Date]) and is extremely useful for machine monitoring.
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Chapter 7

Customer Support

Warranty and After Sales Service

In the event of a fault or problem occurring with your software during the
warranty period, the software should be returned to Pulsar Instruments Plc in
its original packaging or to an authorized agent. Please enclose a clear
description of the fault or symptom.

Detalls of the warranty cover are available from Pulsar Instruments Plc or an
authorized agent.

Should you have any queries regarding the use of the software or wish to
suggest future improvements or additions then please feel free to contact
Pulsar at sales@pulsarinstrument.com

For warranty return to: -

Pulsar Instruments Plc
The Evron Centre

John Street

Filey

North Yorkshire

YO14 9DW

United Kingdom

Telephone: +44 (0)1723 518011

Fax: +44 (0)1723 518043
Email: sales@pulsarinstrument.com
Web: www.pulsarinstruments.com

During the one year warranty period of your software, upgrades or bug fixes
will be issued free of charge whenever they become available.
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Disclaimer

Whilst every effort is made to ensure the accuracy and reliability of both the
software described and the associated documentation, Pulsar Instruments
Plc makes no representation or warranties as to the completeness or
accuracy of this information.

Pulsar Instruments Plc assumes no responsibility or liability for any injury, loss
or damage incurred as a result of misinterpreted or inaccurate information.

Any documentation supplied with your product is subject to change without
notice.

Software Details

For your records and for future correspondence with Pulsar Instruments Plc
regarding your instrument, please complete the following details: -

Software Version

Serial Number

Purchase Date
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